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Agenda 

1. Usability Enhancements 

2. Adaptive Meshing 

3. Weld Connections 

4. Spaceclaim 

5. Material Modeling Improvements 

6. V15 reminders 
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Moore’s Law 

Simulation is increasingly underutilized! 
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Analyst vs Advocate 

Analyst 

Get a 
Project 

Work on 
the 

Project 

Document 
the 

Results 

Submit 
the 

Project 
Advocate 

Find  
Opportunities 

Scope 
Projects 

Direct the 
Analysis 

Quantify 
Savings 
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So what’s the difference? 

Analyst 

Unknown 
Value 

40 hours 
Impact on 

Profits 

Advocate 

Valued 
Resource 

Impact 
Multiplies 

With more projects, whose expertise can you leverage? 
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Use Epsilon as a Resource! 

Design 

• Initial Analysis 

• Parametric 
Studies 

Prototype 
• Redesign 

• Failure Modes 

Sustain 

• Design 
Improvements 

• Reduce Costs 
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What’s the Next Step? 

• Let’s get an NDA in place 

– Just a phone call away 

• Discover Opportunities for Simulation 

– Epsilon has a proven approach 

• Become a Champion of FEA 

– Promote FEA as a necessity  
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Usability Enhancements 
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Folders 

• Parts, connections, boundary conditions, etc. 
can be organized into groups 

• Easily suppress whole groups without 
hunting for each item 
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Node/Element Numbers  

• Display Node/Element numbers through 
“Annotation Preferences”  

• Show specific range of node/elements on the model 
if needed. 
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Sub-Assemblies 

• Improved assembly management 

– Can import more details from sub-models 

– Improved detail management from folders 

– “Preview Assembled Geometry” available 

From ANSYS V16 Release Notes 

From ANSYS Release Notes 
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Face 

• Now you can split faces using planes and surfaces! 
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Detach and Body Repair 
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Vector Plotting controls 

• Vector Plotting allows suppression of principals 
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Analysis Options 

• Tabular participation factor data for modal analyses 

• Results Option: set default for calculating time 
history 

• Can now plot stresses and strains for line bodies 
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• Explode! 

 

 

 

 

From ANSYS Release Notes 

Misc.  
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• Can open Mechanical in read-only 
mode (avoids tying up license) 

• Filter Tree Based on Visible Bodies 

• Selection Information tells you 
distance between selected items 

 

From ANSYS V16 Release Notes 

Misc.  



 18 

… within Epsilon 

ANSYS User Meeting 

• Thermal Fluid Line Bodies: Import pipe volumes as line 
bodies to model thermal fluid flow 

Image courtesy of PADT 

Misc.  
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• Buckling: Now includes nonlinear effects, renamed 
Eigenvalue Buckling 
– Incremental loads may now be added after static pre-stress 

– Joints now supported in linear buckling 

 

From ANSYS Release Notes 

Misc.  
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Misc.  

• Distributed Mass 
– Paint bodies, or surfaces with specified mass 

• Element Orientation—Use surface/edge guides 
– Can adjust normals within Mechanical – but operates on entire body 

• Joint Element Control – define elements used in joints 
– Contact or MPC184’s 

• Solver Pivot Checking – continue solving when 
underconstraint detected 
– V15 became more sensitive to pivot errors 

– V16 let’s us better ignore these errors  

– See PIVCHECK MAPDL command) 
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Misc.  

• IGES Import Instancing 
– Can reuse meshing for instanced bodies, for example 

• DM – Upgrade Feature Version 
– Can choose whether to update legacy .agdb’s 

• DM – sort parts alphabetically 

• Geometry attachment up to 2x faster 

• Multi-threaded (parallel CPU) contact detection 
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Meshing 
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Mesh Connections 

• ANSYS inc. continues 
trend avoiding shared 
topology.   

• This trend exists from 
WB inception. 

• Also note Spaceclaim 
alongside DM info. 

From ANSYS Release Notes 
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Mesh Connections 

• Connect parts/bodies in ANSYS by selecting the common 
point/edge/face between the two. 

• Allows for greater control of what is/isn’t connected 

• Connections can be “automated” similar to contacts 

• Large number of connections fail in our test cases 
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Node Merging 

• Connect nodes between parts/bodies in ANSYS by selecting 
the common points/edges/faces. 
– Like NUMMRG command in MAPDL 

• Allows for tolerance control between present node 
connections within the model 
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What’s the Difference?!? 

• Mesh Connection: 
– Mesh connection will move 

the nodes of the slave 
geometry to match the 
master geometry. Both 
bodies will share common 
nodes between the two. 

• Node Merge: 
– Node merges will merge any 

nodes that are within the set 
tolerance. Small tolerances 
merge nodes on top of each 
other—large tolerances 
forces nodes to merge over a 
larger area. 

Tolerance: 1e-5, Nodes Merged: 2 Tolerance: .25, Nodes Merged: 25 
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Node Moving 
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Display Element Quality 

• Display the mesh quality under “Mesh Details” 

• Quick and easy way to look at the effects of mesh 
connection/node merging/node moving 

• Uses combination of previous element 
quality viewing options 
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• New feature for nonlinear, large deflection 
analyses: “Nonlinear Adaptive Region” 

• Intended to ressolve convergence issues with high 
deformation load cases, esp. elastomers 

• Extending trend from earlier “rezoning”  

– previously only in MAPDL 

• Still has lots of caveats 

– Commercial application is still narrow/costly 

 

Adaptive Remeshing 
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• Implement during Solution options 

– Define subset of timesteps to check: less computation 
time 

– Multiple criteria options: skewness, strain energy, 
bounding box 

– Only remeshes when criteria is met and only in problem 
areas 

 

Adaptive Meshing 
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• Must use linear tetrahedral elements for 3D bodies 
– SOLID285’s  

• Scope to solid bodies or elements only – no shells 

• Altered mesh cannot be shared between linked analyses 

• No explicit indication where a remesh has occurred 

• May introduce solution chatter that would otherwise not be 
present 

 

Adaptive Mesh: Limitations 
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Cannot be used in combination with the following 
features/conditions on the same part: 
• Cyclic Symmetry 

• Contact Formulations: Normal Lagrange (3D), MPC, and Beam 

• Contact Behaviors: Auto Asymmetric 

• Point Mass, Beam Connection, Joints, Spring, and Bearing 

• Remote Force, Remote Displacement, Moment, Thermal Condition, and 
Remote Point 

• Spatially varying boundary conditions 

• Coupling 

• Constraint Equation 

 

 

Adaptive Mesh: Limitations 

From ANSYS V16 Release Notes 



 33 

… within Epsilon 

ANSYS User Meeting 

For 3D bodies, you must set the mesh to 
linear tetrahedral: 
• Insert->Method->Definition->Method->Tetrahedrons 

• Insert->Method->Definition->Method->Element Midside 
Nodes->“Dropped” 

Large Deflection must be turned on: 
• Analysis Settings->Solver Controls->Large Deflection-> On 

Store Results At All Time Points: 
• Analysis Settings->Output Controls->Store Results At-> All 

Time Points 

 

It may also be helpful to define more 
loading substeps to check at more points 
before the elements distort too far 
 

 

Adaptive Meshing: Procedure 



 34 

… within Epsilon 

ANSYS User Meeting 

• With environment selected in 
the tree, insert Nonlinear 
Adaptive Region or select it 
from the Conditions toolbar 

• Can only be scoped to a body 
or named selection of 
elements 

• Select criterion and time 
range to check upon 

Adaptive Meshing: Procedure 
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Check force/displacement convergence graphs or 
tabular data to find which time step/substep a remesh 
was applied 

Adaptive Meshing: Results 
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Compare pre-mesh change and post-mesh change 
substeps to find regions of improvement 

Adaptive Meshing: Results 
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Meshing misc. 

• Fixed Size Function For Sheets – set all surface bodies to 
same mesh density 

• Face Meshing can be done without mapping– fewer 
elements in noncritical bodies attached to critical ones 

• Tetra/Pyramid Free Mesh Type – give bodies a pyramidal 
surface, tetrahedral core mesh 

• Vertex alignment options available in MultiZone meshing – 
previously only in face meshing 

• Inflation allowed for 2D mapped surfaces 

• Can now sweep across multiple parts or named selections, 
and define sweep element size with numerical argument or 
edge reference 
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Weld Connections 
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Weld Connections 

• ANSYS has started to implement welds in DM 

• Two types of weld: Continuous and Skip (beta feature) 

• Project->Surface Extension 
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Weld Connections 
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Weld Connections 

• Limitations 

– Only works on perpendicular surfaces 

– Only works in DM 

– Watch out for partial welds (see picture below) 
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Contacts misc 

• Contact smoothing for more accurate 
circular/cylindrical/spherical contact regions – contact is 
mapped based on geometry, not mesh 

• Element orientation (bodies only) 

• Bolt tool probes results for all pretensions 

• Contact results report far contact fields as undefined rather 
than zero 

 

 

 

V15 

 

 

V16 
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Spaceclaim 
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Spaceclaim 

• Community usage? 

• Can now read DM files 

• Yes—you do need a separate license to run it 

• User friendly, terrific user experience after learning  

• Similar to Solidworks in feel 

• No design tree! Able to make changes without corrupting the rest of the 
model! 
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Material Modeling Improvements 
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Composites 

• Better tree structure 

• Imperfection modeling 

• More individual ply control 

– Fiber direction 

– Ply stresses 

 

 

From ANSYS V16 Release Notes 
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Inclined Crack Modeling 

• Crack coordinate system created for each crack 

• More crack definition features to work with new 
crack coordinate system 

 

From ANSYS V16 Release Notes From ANSYS V16 Release Notes 
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V15 - Reminders 



 49 

… within Epsilon 

ANSYS User Meeting 

Preprocessing 

• Promote a scoping to a named selection! 
– Consider making named selections the norm /best practice 

– For those who don't plan well... 

• New mapping processor 
– Can map stress/strain data from text file onto nodes 

– UV mapping algorithm (surfaces don't have to be coincident) 
• Projects data onto surface 

• Eases mapping from deformed to unreformed shapes! 
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Meshing 

• Local Min-Size meshing 
– Overrides min-size in advance meshing (proximity and/or curvature) 

• Mesh failures are color coded / highlighted by white axes 

Images from help manual 
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Solver Improvements 

• GPU added to solve process settings / GUI 
– Can have 1 GPU on SMP using Sparse now 

• New Arc-length methodology 
– Now based on “Crisfield“ theory 

– Less likely to retrace own steps backward 

– Supposed to do better with plasticity 

• NROPT,UNSYM exposed in WB 
– Can aid help with non-convergence/unstable problems 

– More expensive computationally (30% on solve time?) 

– Can use the WB/Mechanical generated springs 

• Sparse has better (um, different) detection/handling of 
singular matrices. 
– PIVCHECK command can be disabled. 
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• Contact Debonding! 
– CZM technology 

– Uses CONT17X 

– Define material model 

• Interface Delamination 
– uses INT20X elements  

– more complex separation 
functions 

Contact Debonding 
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More Contact 

• MAPDL Contact -- user-programmable definitions 

– Stiffness based on frequency, nonlinear, etc. 

• FTOLN now affects FKN! 

• Contact surface wearing 

– “Archard” wear model (or user defined subroutine) 

– Moves contact node by depth of calculated wear 
• Controlled via material property, TB, WEAR 

– Total wear stored in NMISC data 
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Contact 

• Bolt thread modeling 
– Need to have a refined mesh 

– Specify bolt axis/CS 

– Enter Pitch, Thread Angle, Diameter, etc. 

Image from help manual 
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Shell to Solid Submodels 

• 3D shell model to 3D solid model 

– In “Transfer Key” specify Shell-Solid 

• Imported Loads detail window 

– As with most submodels, beware 
the rotating nodes CS’s 

– UY mapped for nodes within center 
region (20% the thickness)… 

• Beware over/under constraint here. 

• Ideally this would be a single set of nodes 

 

Image from help manual 
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Automatic Rezoning 

• Manual Rezoning fully implemented in MAPDL 

– Writes deformed nodes 

– Makes facets/geometry in the deformed shape 

– Meshes new volume/area 

– Transfer displacements from previous analysis 

– Resolves -- Lather, rinse, repeat… 

• Automatic Rezoning just splits the element edges 

– a.k.a. “Mesh Nonlinear Adaptivity”  

– An EREFINE essentially. 

– Manual is pretty clear this won’t help element shape 
distortion errors… yet. 
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Shared Topology 

• Toggles on/off – if you don’t know about it, it’s a must read 
to avoid problems. 
– Default is to execute behind the scenes on way to Mechanical 

– Can be forced to earlier location in the tree 
• And then hidden – so you won’t know that it is happening prior to other 

operations! 

• Face coloring by shared topology specification 
– Not by success / actual connection 

• Specify face joints manually… 
– Must be two parts within same body  

– Can be done after shared topology operation 


